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Introducción

Este documento describe cómo actualizar una imagen de software en los dispositivos Cisco ASA 
5500 con Cisco Adaptive Security Device Manager.

Prerequisites

Requirements

No hay requisitos específicos para este documento.

Componentes Utilizados

La información que contiene este documento se basa en las siguientes versiones de software y 
hardware.

Cisco ASA 5500 y ASA 5500-X 9.1(2) y posteriores•



Cisco ASDM 7.1 y posterior•

La información que contiene este documento se creó a partir de los dispositivos en un ambiente 
de laboratorio específico. Todos los dispositivos que se utilizan en este documento se pusieron en 
funcionamiento con una configuración verificada (predeterminada). Si tiene una red en vivo, 
asegúrese de entender el posible impacto de cualquier comando.

Productos Relacionados

Esta configuración también se puede utilizar con la versión 9.x del software del dispositivo de 
seguridad de Cisco ASA serie 5500-X.

Convenciones

Consulte Convenciones de Consejos Técnicos de Cisco para obtener más información sobre las 
convenciones sobre documentos.

Descargar Software

Para descargar la versión requerida de las imágenes del software ASA y las imágenes del 
software ASDM, utilice estos enlaces:

Descarga de la versión del software Cisco ASA (sólo clientes registrados)•

Descarga de la versión del software Cisco ASDM (sólo clientes registrados)•

Nota: se necesitan credenciales de usuario de Cisco válidas para descargar este software 
desde Cisco.com.

Compatibilidad entre ASA y ASDM

El enlace que se muestra se actualiza con la versión de ASDM recomendada por Cisco para cada 
versión de ASA.

Compatibilidad de ASA y ASDM

Ruta de actualización de ASA

El enlace mostrado proporciona la ruta de actualización para ASA. Algunas versiones requieren 
una actualización provisional antes de poder actualizar a la última versión.

Ruta de actualización de ASA

Actualización de una Imagen de Software ASA con el Uso de 

https://software.cisco.com/download/home/278875415
https://software.cisco.com/download/home/279513399/type/280775064/release/7.17.1.155
/content/en/us/td/docs/security/asa/compatibility/asamatrx.html#pgfId-121785
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/planning.html#id_58680


ASDM 7.x

Complete estos pasos para actualizar una imagen de software en ASA 5500 con el uso de ASDM.

1. Cuando ASA esté en el modo de contexto único, seleccione Tools > Upgrade Software from Local Computer... 
desde la ventana principal del ASDM.

 

Cuando ASA se ejecuta en el modo de contexto múltiple, el Upgrade Software from Local Computer opción 
bajo el Tools La ficha de menú sólo está disponible en el contexto Sistema.

 
2. Seleccione ASA como el tipo de imagen que desea cargar en la lista desplegable.



 

 
3. Haga clic Browse Local Files... o escriba la ruta en el Local File Path para especificar la ubicación de la 
imagen de software en el PC. 
 
4. Haga clic en Examinar Flash... 
 
5. Aparece el recuadro de diálogo Examinar Flash, en el que el nombre de archivo se introduce 
automáticamente. Si el nombre de archivo no aparece, introdúzcalo manualmente en el File Name 
campo. Haga clic en Aceptar cuando termine. 
 

 
 
6. Una vez especificados los nombres de archivo local y remoto, haga clic en Upload Image.

 



 
 
7. Se muestra una ventana de estado mientras ASDM escribe la imagen en flash. Una vez 
finalizada, se muestra una ventana de información que indica que se ha producido una carga 
correcta y pregunta si la imagen se debe establecer como imagen de inicio. Seleccionar Yes.



Haga clic en OK en el cuadro de diálogo Información y haga clic en Close en el cuadro de diálogo 
Cargar imagen desde PC local. 

8. Seleccione Tools > System Reload desde la ventana Home para recargar el dispositivo.

 
 

Aparece una nueva ventana que verifica los detalles de la recarga. Seleccionar Save the running 

configuration at the time of reload y, a continuación, seleccione un momento para volver a cargar. Las 
opciones de tiempo incluyen:

Ahora - Reinicia el dispositivo inmediatamente.•
Retraso por - Especifica los minutos u horas que se necesitan para recargar el dispositivo.•
Programado para — Especifica la fecha y hora de la recarga del dispositivo.•

 
Además, especifique si el dispositivo debe forzar una recarga inmediatamente cuando falle una 
recarga programada. Cheque On Reload failure, force an immediate reload after y, a continuación, especifique un 
tiempo de espera máximo. Este es el tiempo que el dispositivo de seguridad espera para notificar 
a otros subsistemas antes de un apagado o reinicio. Después de este tiempo, se produce un 
rápido (forzado) shutdown/reboot Haga clic en Schedule Reload.

 



 
Una vez que la recarga está en curso, un Reload Status se muestra para indicar que hay una recarga 
en curso. También tiene la opción de salir del ASDM . 
 

Nota: Inicie ASDM nuevamente después de que ASA se recargue.

 



Actualice la imagen de ASDM con el uso de ASDM 7.x.

Complete estos pasos para actualizar una imagen de software en el ASA 5500 con la de ASDM.

1. Seleccione Tools > Upgrade Software from Local Computer... desde Home del ASDM.

 



 
 
2. Seleccione ASDM como el tipo de imagen que se va a cargar de la lista desplegable.

 
3. Haga clic Browse Local Files...  o escriba la ruta en el Local File Path para especificar la ubicación de la 
imagen de software en el PC.

Haga clic en Browse Flash....

R Browse Flash se muestra con el nombre de archivo introducido automáticamente. Si el nombre de 
archivo no aparece, introdúzcalo manualmente en el File Name campo. Haga clic en OK cuando haya 
terminado.



 
4. Haga clic OK cuando la imagen se actualiza con la nueva imagen.

 
5. Seleccione File > Save Running Configuration to Flash desde Home del ASDM.

 



 
Salga del ASDM e inicie sesión nuevamente para administrar el ASA con la imagen actualizada 
del ASDM.

Actualización de ASA y ASDM mediante una imagen Descargar 
Directamente desde CCO

 
Complete estos pasos para actualizar una imagen de ASA y ASDM directamente desde CCO. 
 
1. Seleccione Tools > Check for ASA/ASDM Updates... desde Home del ASDM.

 
2. Cuando aparezca la solicitud de nombre de usuario y contraseña, proporcione las credenciales 



Cisco.com y haga clic en Login.

 
 
3. El Cisco.com Upgrade Wizard .... En el Overview sección, haga clic en Next. 
 



 
 
4. En el Select Software , compruebe el software que debe actualizarse. Si es necesario actualizar 
tanto ASA como ASDM, marque ambas opciones. 
 



 
5. En la lista desplegable Versión de ASA, seleccione la versión a la que debe realizarse la 
actualización de ASA.



 
6. En la lista desplegable Versión de ASDM, seleccione la versión en la que debe realizarse la 
actualización de ASDM. Haga clic en Next cuando se hayan seleccionado las versiones 
adecuadas.



 
7. En el Review Changes , revise los cambios y haga clic en Next.



 
8. La instalación de las imágenes comienza y el progreso general se puede ver como se muestra. 
Una vez completada, haga clic en Finish. 
En el Results , compruebe la sección Save configuration and reload device now opción. Haga clic en Finish.



 
9. El Reload Status mientras el dispositivo se recarga.



 
10. Haga clic Exit ASDM y vuelva a iniciar sesión una vez que el dispositivo se active tras la recarga.

Uso de CLI para actualizar una imagen de software y una imagen 
ASDM

Se requiere un servidor TFTP para actualizar o degradar una imagen de software, así como una 
imagen ASDM para un ASA. Consulte Selección y uso del servidor TFTP para obtener más 
información sobre la selección del servidor TFTP.

 copy tftp flash permite que una imagen de software se descargue en la memoria Flash del firewall 
mediante TFTP. Use el comando copy tftp flash con cualquier modelo de dispositivo de seguridad. La 
imagen descargada ahora se puede utilizar en el próximo reinicio mediante un cambio de la 
variable del sistema de arranque para apuntar a esta imagen.

Este es el resultado del copy tftp flash comando:

 

copy tftp[:[[//location] [/tftp_pathname]]] [[flash/disk0][:[image | asdm]]]

https://www.cisco.com/c/es_mx/support/docs/routers/10000-series-routers/48700-tftp-server.html


 

Para el modo multiple context, realice estos pasos en el espacio de la ejecución del sistema.

Nota: Para ASA, la palabra clave disk0 reemplaza a flash en el copy comando.

Si el comando se utiliza sin los parámetros opcionales location o pathname, la ubicación y el 
nombre de archivo se obtienen del usuario de forma interactiva mediante una serie de preguntas 
similares a las presentadas por el software Cisco IOS®. Si sólo se introduce un signo de dos 
puntos, los parámetros se toman del tftp-server configuración del comando. Si se proporcionan otros 
parámetros opcionales, estos valores se utilizan en lugar de los parámetros asociados tftp-server 
configuración del comando. Si es un de los los parámetros optativos, tales como los dos puntos y 
cualquier carácter después de ellos, el comando se ejecuta sin un prompt para la entrada de 
usuario.

La ubicación es una dirección IP o un nombre que se resuelve en una dirección IP mediante el 
mecanismo de resolución de nombres del dispositivo de seguridad, que actualmente es estático y 
está asignado por el name y names comandos. El dispositivo de seguridad debe saber cómo llegar a 
esta ubicación mediante la información de la tabla de routing. Esta información la determina el IP 

address,el routeo el RIP comandos. Esto depende de su configuración.

La cadena de caracteres puede incluir cualquier nombre de directorio además del componente 
más reciente real de la trayectoria al archivo en el servidor. La cadena de caracteres no puede 
contener espacios. Si el nombre de un directorio tiene espacios, configure el directorio en el 
servidor TFTP en lugar de en el copy tftp flash comando. Y si su servidor TFTP está configurado para 
apuntar a un directorio en el sistema desde el cual descarga la imagen, sólo utilice la dirección IP 
del sistema y el nombre de archivo de la imagen. El servidor TFTP recibe el comando y determina 
la ubicación del archivo real de su información de directorio raíz. El servidor entonces descarga la 
imagen TFTP al dispositivo de seguridad.

Estos comandos son necesarios para actualizar la imagen del software, así como la imagen 
ASDM, y convertirla en una imagen de inicio en la próxima recarga.

 
<#root>

ASA

#copy tftp [[flash:/disk0:][software image name/asdm image name]]

 

!--- Command to set an image as bootup or specify the 

!--- ASDM image file.

 
 
ASA(config)

#boot system [flash:/disk0:]/[software image name]

 

!--- Save active configuration to the Flash.



 
ASA

#write memory

 

!--- Reboot the security appliance and load 

!--- with the new boot image as per the configuration file.

 
ASA

#reload 

 

Ejemplo:

 
<#root>

ASA-5512# copy tftp: disk0: 
 
Address or name of remote host []? 172.16.31.1 
Source filename []? asa916-smp-k8.bin 
Destination filename [asa916-smp-k8.bin]? 
Accessing tftp://172.16.31.1/asa916-smp-k8.bin...!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
Writing file disk0:/asa916-smp-k8.bin... 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
38043648 bytes copied in 32.290 secs (1188864 bytes/sec) 
 
ASA-5512# sh disk0 
--#--  --length--  -----date/time------  path 
 

 191  38191104    Nov 21 2014 21:07:48  asa912-smp-k8.bin 

  192  17906032    Apr 08 2015 22:33:44  asdm-713.bin 

  193  26350916    Apr 09 2015 06:28:20  asdm-741.bin 

  194  38043648    May 10 2015 02:14:06  asa916-smp-k8.bin 

 

4118732800 bytes total (3556712448 bytes free) 
 
 

!--- Command to set "asa916-smp-k8.bin" as the boot image.

 
ASA-5512(config)

# boot system disk0:/asa916-smp-k8.bin

 

!--- Command to set "asdm-741.bin" as the ASDM image.

 
ASA-5512(config)

# asdm image disk0:/asdm-741.bin



ASA-5512

# write memory

ASA-5512

# reload 

 

Nota: Cuando intente actualizar la imagen en el ASA desde un servidor FTP, utilice el copy ftp 

flash comando. Este comando permite especificar parámetros, como la dirección IP remota y 
el nombre del archivo de origen. Este procedimiento es similar al TFTP. Sin embargo, una 
limitación es que no puede modificar la interfaz IP/de origen remota (como puede hacer con 
TFTP). En el modo TFTP, las opciones especificadas con el tftp-server se puede extraer y 
ejecutar. Pero con FTP, no existe tal opción. De forma predeterminada, la interfaz de origen 
es siempre la externa, que no se puede modificar. Es decir, el servidor FTP es accesible 
desde la interfaz externa.

Verificación

Utilice esta sección para confirmar que la actualización de software se ha realizado 
correctamente.

El Analizador de Cisco CLI (sólo para clientes registrados) admite determinados show comandos. 
Utilice el Analizador de Cisco CLI para ver un análisis del show resultado del comando.

Después de que ASA se recargue y haya iniciado sesión con éxito en ASDM otra vez, verifique la 
versión de la imagen que se ejecuta en el dispositivo. Consulte la General de la ficha Home para 
obtener esta información.

Estos comandos de CLI se utilizan para verificar la actualización:

Show version — Muestra la imagen actual con la que se reinicia el ASA.1. 
Show bootvar — Muestra la prioridad de la imagen que se utilizará después de la recarga.2. 

https://cway.cisco.com/cli
http://tools.cisco.com/RPF/register/register.do
http://tools.cisco.com/RPF/register/register.do


Show asdmimage — Muestra la imagen ASDM actual utilizada por el ASA.3. 

Troubleshoot

Actualmente no hay información específica disponible para resolver problemas de esta 
configuración.
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https://www.cisco.com/c/es_mx/support/security/asa-5500-series-next-generation-firewalls/products-release-notes-list.html
/content/en/us/td/docs/security/asa/roadmap/asa_new_features.html
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/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/asa-appliance-asav.html#concept_xxv_yvn_kkb


Acerca de esta traducción
Cisco ha traducido este documento combinando la traducción automática y los recursos
humanos a fin de ofrecer a nuestros usuarios en todo el mundo contenido en su propio
idioma.
 
Tenga en cuenta que incluso la mejor traducción automática podría no ser tan precisa como
la proporcionada por un traductor profesional.
 
Cisco Systems, Inc. no asume ninguna responsabilidad por la precisión de estas
traducciones y recomienda remitirse siempre al documento original escrito en inglés (insertar
vínculo URL).


